
Agent Contents
Agent is a powerful and easy-to-use Usenet newsgroup reader.    It allows you to browse newsgroups 
both online and offline.    Before you start using Agent, please take a quick look at Getting Started.

For more information about using Agent, see How to Use Agent.

If you have any comments, questions, or problems with Agent, see How to Contact Forté.

To help familiarize yourself with Agent’s Newsgroup window, click on the various components of the 
picture below.



How to Contact Forté
Forté is dedicated to providing the most-powerful and easiest-to-use Usenet Newsreader for Windows.    
In order to do this, we need to hear from you.    You can contact us in any of the following ways:

World Wide Web
Information about the latest Agent release and answers to the most frequently asked questions can 
be found on our Web site at http://www.forteinc.com/forte/.

Usenet
After our World Wide Web site, the fastest way to get your questions answered may be through the 
alt.winsock newsgroup.    Although our customer support staff monitors this newsgroup, frequently
other Agent users will answer your questions before we do.

Email
To tell us directly what you think of Agent or what features you’d like to see added, select Comments 
from the Post menu or send email to agent-comments@forteinc.com.

To report a problem with Agent, select Bug Report from the Post menu or send email to agent-
bugs@forteinc.com.

Due to Agent’s overwhelming response, we may not be able to follow up individually to every email 
comment and bug report.    However, rest assured that we do read all the emails we receive.    If you 
feel you’re not getting adequate response from us, please send email to agent-
flame@forteinc.com.



How to Use Agent
Before you start using Agent, please take a quick look at Getting Started.

Once you’re up and running, check out the topics below for more help using Agent.

How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader

How to Post Articles
How to Send Email
Making Sure Articles and Emails Were Sent Properly

How to Send a Binary Attachment
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent

Watching and Ignoring Threads
ROT13 Encoding and Decoding
Copying a WWW URL to the Clipboard
How to Get All the Articles in a Group

How to Control When Agent Purges Articles
How to Control When Agent Marks Articles Read



Add Signature dialog box (Signatures dialog box, File menu)
Use this dialog box to enter the name of a new signature.

Name
Enter the name of the new signature



Use Information From Another Program dialog box
Use this dialog box to select the program from which Agent will acquire its basic setup information.

Program
Select the program from which you wish to get the initialization information.

Copy program’s list of newsgroups
Check this box if you want Agent to use the selected program’s newsgroup list to fill in its own list.    If 
you have subscribed to newsgroups in the selected program, you will be subscribed to those groups 
in Agent as well.
Note: If the newsgroup list in the other program is out of date, either uncheck this box or choose 
Refresh Group List from the Online menu at a later time.



Use Information From dialog box
Use this dialog box to enter the location of the program from which Agent will acquire its basic setup 
information.

Enter the name of the directory...
Type in the other program’s complete path, including drive.    For example, C:\TRUMPET.



Window Layout dialog box (File menu)
Use this dialog box to select the layout of the panes in the current window.    You can choose how the 
panes should be arranged and what the contents of each pane should be.

Layout of Panes
These buttons show all of the available pane layouts.    Click on a button to choose a layout.

Contents of Panes
For the layout you have selected above, these buttons show all of the ways that you can organize the 
Group Pane, Article Pane, and Body Pane.    The box with black text represents the Group Pane.    
Red text represents the Article Pane.    The Body Pane has blue text.    Click on a button to choose an 
organization.

After you have chosen a layout and pressed OK, the window will update to reflect your selection.    If you 
desire, resize the panes by dragging the border between the panes.

TIP:    To show only one pane at a time, select Zoom Window from the Navigate menu or press Z.

If you would like to have a particular layout be the one used when you start Agent or open a new 
Newsgroup window, choose Save As Default Window Layout from the File menu.    This command saves 
the pane layout, pane sizing, and whether or not a pane is zoomed.



Preferences dialog box (File menu)
Attachments Tab view
Use this dialog box to define settings that affect how Agent works.    This tab controls how binary 
attachments sent by you are formatted.    For more information on sending attachments, see How to Send
a Binary Attachment.

Send attachment as multiple messages
Select this option to split long attachments into multiple messages.    The size of each attachment is 
dictated by the number you enter into the Lines per Messages box.

Send attachment as a single message
Select this option to include the entire attachment in one message, no matter how long the 
attachment is.

Send text as preface message
Select this option to send an additional message ahead of the attachment message(s).    This is useful
because it allows people to read a description of the attachment before downloading it.

Send text in first message
Select this option to include the description of the attachment in the attachment’s first message.

Do not send any text
When this option is selected, Agent will only send the attachment.    Any other text or description you 
enter into the Compose window will be ignored.



Preferences dialog box (File menu)
Colors Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls the color of text in 
Agent.

Normal Lines
Choose the color for groups and “read” article headers.

Unread Articles
Choose the color for unread article headers.

Highlighted Unread Articles
Choose the color for unread article headers when they are selected.    This is usually the inverse of 
the Unread Articles color.

Normal Text
Choose the color for body text.

Quoted Text
Choose the color for response text within an article’s body.



Preferences dialog box (File menu)
Confirmations Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls the confirmation 
messages Agent displays.    These messages warn you when you are about to perform an irreversible 
action.

Delete groups
Check this box and Agent will display a confirmation message when you manually delete a group.

Delete articles
Check this box and Agent will display a confirmation message when you manually delete an article.

Delete outbox messages
Check this box and Agent will display a confirmation message when you manually delete a posting or 
email in the Outbox window.

Close message composition window
Check this box and Agent will display a confirmation message when you close a posting or email 
window without sending the message first.

Stop online tasks
Check this box and Agent will display a confirmation message when you cancel an online operation.

Close program while online tasks are running
Check this box and Agent will display a confirmation message when you exit Agent while it is 
communicating with the news server.

Default action in confirm dialogs is YES
Check this box to make “Yes” the default button on all confirmation dialog boxes.    The default button 
is the one activated when you press the Enter key.



Preferences dialog box (File menu)
Display Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how Agent’s 
newsgroup window appears and behaves.

Show Toolbar
Check this box to display the Agent toolbar directly below the menubar.

Show Status Bar
Check this box to display the Agent status bar at the bottom of the window.

Tab Spacing
Enter the length of tab stops, in characters.

Quoted Text
Enter the characters that commonly appear in follow-up messages signifying that text on the same 
line is quoted from the original message.    Agent displays this text in the color defined by the Quoted 
Text setting on this dialog box’s Colors tab.

Scroll Margins
Enter the number of rows you want to remain visible above or below the highlighted row when 
scrolling up or down in the Article and Body panes.

Follow-Up Indentation
Enter the amount of space, in characters, that follow-up articles should be indented from their parent 
in the Article Pane.

Maximum Follow-Up Level
Enter maximum number of response levels (responses to responses) that you want displayed in the 
Article Pane.    Any responses deeper than this appear at the most indented level.

Show Threads Initially Collapsed
Check this box to initially hide all responses in the Article Pane.

Automatically expand threads containing new articles
Check this box to have Agent automatically expand a thread when skipping to an unread article within
a thread.    Agent expands the thread only if you had previously retrieved and read the first article in 
the thread.

Enable threading by subject
Check this box to have Agent include articles with the same name under the same thread.    People 
frequently mispost responses and this helps match follow-ups with the article to which they are 
responses.



Preferences dialog box (File menu)
Message Posting Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how messages that 
you send are formatted.

Line length
Enter the maximum number of characters that can appear on a single line.    Agent automatically word
wraps any lines longer than this.

Save sent messages in outbox
Check this box to save a copy of all messages that you send.    Choose Open New Outbox Window 
from the File menu to view your saved messages.    For more information on the Outbox window, see 
Making Sure Articles and Emails Were Sent Properly.

Include original text
Check this box to include a copy of the original text in follow-up articles or emails.

Quote original text in forwarded emails
Check this box to insert the quote prefix (defined below) in front of each line of text from the original 
posting when forwarding messages to people via email.

Prefix for quoted lines
For follow-up articles and emails, enter the character(s) that signify that the text on the same line is 
quoted from the original message.

Follow-Up article introduction
Enter the text to appear just above quoted lines in follow-up articles.

Email reply introduction
Enter the text to appear just above quoted lines in email replies.

Forward email introduction
Enter the text to appear just above quoted lines in forwarded emails.



Preferences dialog box (File menu)
Online Operation Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls Agent’s behavior 
while online.

Configure for Offline Operation
Press this button if you want to use Agent as an offline newsreader.    This button optimally configures 
the remaining controls in this dialog box for offline use.    For more information, see How to Use Agent 
as an Offline Newsreader.

Configure for Online Operation
Press this button if you want to use Agent as an online newsreader. This button optimally configures 
the remaining controls in this dialog box for online use.    For more information, see How to Use Agent 
as an Online Newsreader.

Go offline automatically after...
Enter the number of seconds of inactivity that Agent waits before automatically disconnecting from 
your news server.    If you uncheck this box, Agent will not disconnect from your news server until you 
close the program or uncheck Online from the Online menu.

If you intend to read articles online, you might want Agent to go offline after a few minutes of inactivity.
This gives you time to read articles, but doesn't leave Agent online too long.    If you intend to read 
articles offline, you probably want Agent to go offline immediately (0 seconds of inactivity).

Send keep-alive messages every...
When this box is checked, Agent sends a command to your news server periodically in order to 
maintain the connection to the server.    This option is useful if your computer is connected to the 
server via a dial-up channel that automatically disconnects after a period of inactivity. 

Enter the frequency of keep-alive messages sent from Agent to your news server.    Uncheck this box 
and Agent won’t send any keep-alive messages.

Enable priority article retrieval
When this box is checked, Agent opens a second channel to the news server when you attempt to 
retrieve the body of an article while Agent is already busy performing other online operations.    This 
makes it possible for you to begin reading new articles in one group while retrieving headers in 
another. 

Viewing Unretrieved Articles When Offline
Select the action you want Agent to perform when you are offline and attempt to view an article for 
which you do not have the body.    This setting affects double-clicking and pressing Enter on articles, 
as well as the View Next Unread Article and View Next Unread Article in Thread actions on the 
Navigate menu.



Preferences dialog box (File menu)
System Profile Tab
Use this dialog box to define settings that affect how Agent works.    This tab defines information that is 
required to use Agent.

News Server
Enter the name of your news (NNTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email Server
Enter the name of your email (SMTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Time Zone
Select the time zone you are located in.    Agent uses this setting to convert the times of articles to 
your own local time.    Also, when you post an article or email message, Agent includes your time zone
in the date.

Automatically adjust for Daylight Savings Time
Check this box if you live in a locality that observes Daylight Savings Time between April and October.
During these months, Agent automatically adjusts your time zone to compensate for the time 
difference.



Preferences dialog box (File menu)
User Profile Tab
Use this dialog box to define settings that affect how Agent works.    This tab defines information about 
you.

Email Address
Enter your email address.    When you send a message, this address appears in the "From" field.    
For example: john.doe@forteinc.com

Full Name
(Optional) Enter your full name.    This name is included with your email address in messages that you
send.    It is helpful to include your full name if your email address does not contain your name.    Also, 
some news readers, such as Agent, can display an author’s full name rather than his/her email 
address.

Organization
(Optional) Enter the name of the organization to which you belong.    This name is sent in the 
"Organization" field of articles that you post.    It is not included in your email messages.

Reply To
(Optional) Enter an email address here if you want people to send replies to an address that is 
different than your Email Address listed above.    For example, you may use your business address as
your Email Address, but would prefer that replies be sent to a personal email address.

Server requires authorization login
Check this box if your news server requires a special user name and/or password to login.    When 
checked, Agent will automatically fill in your user name when requested by the news server.

User Name
Enter the user name required by your news server for logging in.

Remember password between sessions
Check this box if your news server requires a special password to login and you want Agent to 
automatically enter that password for you.

Password
Enter the password required by your news server for logging in.



Group Properties dialog box (Group menu)
Marking Articles Read Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls when Agent marks articles read.    Usually, you'll want to mark all existing articles read 
each time you retrieve new articles so that only the new articles are marked unread.    That way, it's easy 
for you to find the new articles. 

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default Group 
Properties dialog box.

New article headers
Check this box to mark all existing articles read each time you retrieve new article headers for this 
group.

Marked article bodies
Check this box to mark all existing articles in this group read each time you retrieve marked article 
bodies for this group.    All the new articles Agent retrieves will be marked unread so that you can 
easily find them.

See Also:
How to Control When Agent Marks Articles Read



Default Group Properties dialog box (Group menu)
Marking Articles Read Tab
Use this dialog box to define your default group settings.    This tab controls when Agent marks articles 
read.

Usually, you'll want to mark all existing articles read each time you retrieve new articles so that only the 
new articles are marked unread.    That way, it's easy for you to find the new articles. 

New article headers
Check this box to mark all existing articles read each time you retrieve new article headers.

Marked article bodies
Check this box to mark all existing articles read each time you retrieve marked article bodies. All the 
new articles Agent retrieves will be marked unread so that you can easily find them.

See Also:
How to Control When Agent Marks Articles Read



Group Properties dialog box (Group menu)
Posting Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls how postings to this group are handled.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default Group 
Properties dialog box.

Signature
Select a signature to use for posting to this group or email replies from this group.



Default Group Properties dialog box (Group menu)
Posting Tab
Use this dialog box to define your default group settings.    This tab controls how postings are handled.

Signature
Select a default signature for all your postings and emails.



Group Properties dialog box (Group menu)
Purging Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls which articles Agent automatically purges (deletes).    For more information, see How to 
Control When Agent Purges Articles.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default Group 
Properties dialog box.

Articles Without Bodies (Headers Only)
The settings in this group apply only to articles for which you have the header but not the body.

Purge articles no longer available on the server
Select this option to automatically delete all headers that the news server has already deleted from its
own list of articles.    Selecting this option makes the list of articles displayed by Agent a mirror image 
of the articles that are available from the server.    This is probably the best option for most groups.

Purge articles older than
Select this option to delete all headers that are older than the specified number of days.

Purge all articles
Select this option to delete all article headers.    Selecting this option reduces the amount of clutter in 
the Article Pane, but prevents you from reading articles that you may have overlooked in previous 
sessions.

Do not purge articles
Select this option if you do not want Agent to automatically delete article headers.    You can delete 
article headers manually by selecting the article and choosing Delete Article from the Article menu.

Articles With Bodies
The settings in this group apply only to articles for which you have retrieved the body.

Purge articles older than
Select this option to delete all articles that are older than the specified number of days.

Purge all articles
Select this option to delete all articles.    This reduces the amount of clutter in the Article pane, but 
prevents you from reading articles that you retrieved in previous sessions.

Do not purge articles
Select this option if you do not want Agent to automatically delete articles.    You can delete articles 
manually by selecting the article and choosing Delete Article from the Article menu.

TIP:    You override automatic article purging for selected articles by “keeping” the article.    To keep an 
article, select it and choose Keep Article from the Article menu.



Default Group Properties dialog box (Group menu)
Purging Tab
Use this dialog box to define your default group settings.    This tab controls which articles Agent 
automatically purges (deletes).    For more information, see How to Control When Agent Purges Articles.

Articles Without Bodies (Headers Only)
The settings in this group apply only to articles for which you have the header but not the body.

Purge articles no longer available on the server
Select this option to automatically delete all headers that the news server has already deleted from its
own list of articles.    Selecting this option makes the list of articles displayed by Agent a mirror image 
of the articles that are available from the server.    This is probably the best option for most groups.

Purge articles older than
Select this option to delete all headers that are older than the specified number of days.

Purge all articles
Select this option to delete all article headers.    Selecting this option reduces the amount of clutter in 
the Article Pane, but prevents you from reading articles that you may have overlooked in previous 
sessions.

Do not purge articles
Select this option if you do not want Agent to automatically delete article headers.    You can delete 
article headers manually by selecting the article and choosing Delete Article from the Article menu.

Articles With Bodies
The settings in this group apply only to articles for which you have retrieved the body.

Purge articles older than
Select this option to delete all articles that are older than the specified number of days.

Purge all articles
Select this option to delete all articles.    This reduces the amount of clutter in the Article pane, but 
prevents you from reading articles that you retrieved in previous sessions.

Do not purge articles
Select this option if you do not want Agent to automatically delete articles.    You can delete articles 
manually by selecting the article and choosing Delete Article from the Article menu.

TIP:    You override automatic article purging for selected articles by “keeping” the article.    To keep an 
article, select it and choose Keep Article from the Article menu.



Group Properties dialog box (Group menu)
Retrieving Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls how and what Agent retrieves from the news server.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default Group 
Properties dialog box.

Retrieve bodies for all new articles
Check this box to have Agent automatically retrieve the bodies for all new articles at the same time it 
retrieves the headers.    This option is handy if you know you'll always want to read all of the articles in
a particular group.    Of course, it takes a lot longer to retrieve the bodies, so you probably don't want 
to select this option for all groups.

Do not retrieve articles longer than...
Check this box and enter a value to limit the size of bodies that are automatically retrieved by the 
option above.    For example, you may want to read most of the articles in a particular group, but not 
necessarily download the group's FAQ every time it is posted.    If you know the FAQ is usually over 
200 lines long, limit the maximum size to 200 lines.

Limit number of headers retrieved per session to...
Check this box and enter a value to limit the number of headers retrieved each time you retrieve new 
headers for the group.    For example, if you limit the number to 100 headers, Agent will retrieve no 
more than the 100 most-recent articles.    This option is handy if you want to catch up with a busy 
group, and know you can't possibly read all the messages posted since you last checked.

View Empty Group Action
Select the option corresponding to the action you want Agent to take when you double-click or press 
Enter on an empty group.

Maximum articles to sample
Enter the maximum number of articles to sample.



Default Group Properties dialog box (Group menu)
Retrieving Tab
Use this dialog box to define your default group settings.    This tab controls how and what Agent retrieves 
from the news server.

Retrieve bodies for all new articles
Check this box to have Agent automatically retrieve the bodies for all new articles at the same time it 
retrieves the headers.    This option is handy if you know you'll always want to read all of the articles in
a particular group.    Of course, it takes a lot longer to retrieve the bodies, so you probably don't want 
to select this option for all groups.

Do not retrieve articles longer than...
Check this box and enter a value to limit the size of bodies that are automatically retrieved by the 
option above.    For example, you may want to read most of the articles in a particular group, but not 
necessarily download the group's FAQ every time it is posted.    If you know the FAQ is usually over 
200 lines long, limit the maximum size to 200 lines.

Limit number of headers retrieved per session to...
Check this box and enter a value to limit the number of headers retrieved each time you retrieve new 
headers for the group.    For example, if you limit the number to 100 headers, Agent will retrieve no 
more than the 100 most-recent articles.    This option is handy if you want to catch up with a busy 
group, and know you can't possibly read all 5 zillion message that were posted since you last 
checked.

View Empty Group Action
Select the option corresponding to the action you want Agent to take when you double-click or press 
Enter on an empty group.

Maximum articles to sample
Enter the maximum number of articles to sample.



Find dialog box (Edit menu)
Use this dialog box to find a group or article.

Find What
Enter the text to search for.

Find First
Press this button to find the first occurrence of the text you entered above.

Find Next
Press this button to find the next occurrence of the text you entered above.



Licensing Agreement dialog box
This dialog box displays Agent’s licensing terms and conditions.    You must accept the terms and 
conditions in order to run the program.

Accept
Press this button to accept the terms of the agreement and run Agent.

Decline
Press this button if you do not accept the terms of the agreement.    Agent will not run if you press this 
button.



Page Setup dialog box (File menu)
Use this dialog box to control the format of articles printed with Agent.

Margins
Enter the left, right, top, and bottom margins in inches.

No fields (Body only)
Select this option to print only the article bodies.

Newsgroup, subject, author, and date
Select this option to print some of the header information along with the article bodies.

All fields
Select this option to print all of the header information along with the article bodies.

None
Select this option to print articles one after the other.

Between articles
Select this option to insert a page break between each article being printed.

Between threads
Select this option to print all the articles in the same thread one after the other and to insert a page 
break between articles of different threads.

Font
Press this button to pick the font used when printing articles.



Server Authorization Password dialog box
Use this dialog box to enter the password required to login to your news server.

Password
Enter the password required by your news server.

Remember password between sessions
Check this box if you want Agent to automatically enter that password for you each time you login to 
the news server.



Refresh Groups List dialog box (Online menu)
Use this dialog box to update your group list and define what Agent should do with groups it no longer 
finds on the news server.

The refresh operation retrieves a complete list of all newsgroups available form the server.    It then adds 
any new groups to Agent’s list of groups, and optionally deletes any groups that are no longer available.    
Tip:    If you only want to retrieve new groups added since the last time you updated your group list, 
choose Get New Groups from the Online menu.

NOTE:    Since this operation retrieves a complete list of groups, it can take several minutes to complete.

Keep all extinct groups
Select this option to maintain groups even if they no longer exist on the server.

Delete extinct groups that are empty
Select this option to maintain groups that no longer exist on the server if the group contains articles.

Delete all extinct groups
Select this option to delete any group which no longer exists on the server.



Rename Signature dialog box (Signatures dialog box, File menu)
Use this dialog box to change the name of a signature.

New Name
Enter a new name for the signature.



Save Article As dialog box (File menu)
Use this dialog box to save one or more articles to a text file.    Select all the articles you want to save 
before choosing this menu option.

If you select a collapsed thread, Agent will save all articles in the thread.    Agent only saves articles 
whose bodies have been retrieved.

File Name
Enter the name of the file you want to save to, or select a file from the list of files. 

Directories
Select the directory where you want to save the file. 

List of File Types
Select the type of file you want to display in the list of files. 

Drives
Select the drive where you want to save the file. 

No fields (Body only)
Select this option to save only the article bodies.

Newsgroup, subject, author, and date
Select this option to save some of the header information along with the article bodies.

All fields
Select this option to save all of the header information along with the article bodies.

Append to Existing File
Check this box if you want to append the articles to an existing file.    If you uncheck this option and 
save the articles to an existing file, Agent will erase the current contents of the file.



Agent Setup dialog box
Fill in this dialog to provide Agent with the basic information needed to read articles and post messages.    
If you don’t want to post articles or emails, you only need to supply the name of your news server and 
time zone.    You can enter the other information later in the Preferences dialog box.

Use Information From Another Program
If you’re already using one of the listed programs, Agent can get most of its basic setup information 
from the other program's configuration files.    Press this button to select the program you use.

News (NNTP) Server
Enter the name of your news (NNTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email (SMTP) Server
Enter the name of your email (SMTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email Address
Enter your email address.    When you send a message, this address appears in the "From" field.    
For example: john.doe@forteinc.com

Full Name
(Optional) Enter your full name.    This name is included with your email address in messages that you
send.    It is helpful to include your full name if your email address does not contain your name.    Also, 
some news readers display full names, when available, rather than email addresses.

Time Zone
Select the time zone you are located in.    Agent uses the time zone to convert the dates of articles to 
your own local time.    Also, when you post an article or email message, Agent includes your time zone
in the date.

Automatically adjust for Daylight Savings Time
Check this box if you live in a locality that observes Daylight Savings Time between April and October.
During these months, Agent automatically adjusts your time zone to compensate for the time 
difference.

Exit Agent
Press this button if you don’t have the basic information available.    The next time you run Agent, this 
dialog box will be displayed again.



Signatures dialog box (File menu)
Use this dialog box to define the signatures you wish to use in your own postings and emails.

Names
This is a list of the signatures you have defined.    To edit a signature, select it in this list and enter the 
new text in the controls below.

Add
Press this button to create a new signature.

Rename
Press this button to rename the signature highlighted in the Names list.

Delete
Press this button to delete the signature highlighted in the Names list.    If you accidentally delete a 
signature, press the Cancel button to close the dialog box and cancel all of your changes.

Default Signature
Select the signature you wish to use by default.    Select [None] if you don't want to have a default 
signature.    When you post an article or send an email message, Agent automatically uses your 
default signature.    You can choose a different signature to be the default for each group (see the 
Group Properties dialog box Posting tab for more information) or override the signature used for a 
specific message (see How to Post Articles for more information).

Text
Enter the text of the signature highlighted in the Names list. If you want a blank line or other separator
to appear between the rest of the message and the signature, you need to include it here.

TIP:    A common convention on the Internet is to begin your signature with a line containing two 
dashes.    For example:

--
Mark Sidell
Forte, Inc.

TIP: To insert a TAB in the text, press Ctrl+TAB.

Use existing file
If you want to share a signature file from another program, enter the name of the file that contains the 
signature.    When you have entered a valid file name, the dialog will display the contents of the file in 
the Text field.    Any changes you make to the signature in this dialog box will be saved to the file, so 
changes here also affect any other program that is using the same file.

TIP: The name of the signature file for the Eudora email program is SIGNATUR.PCE, and is stored in 
the directory where you installed Eudora.

Browse
Press this button to browse for a signature file.



Signatures
A signature is one or more lines of text that Agent automatically places at the bottom of articles and email 
messages that you send.
You can define as many signatures as you wish.    When you create a new message, you can select 
which signature to use with that message.    For example, you can define a "personal" signature and a 
different "business" signature.



View Binary Attachment dialog box (File menu)
Use this dialog box to view an attachment contained in one or more messages.    For more information on 
viewing attachments, see How to Retrieve a Binary Attachment.

Articles
This is a list of the articles containing the attachment.    If the articles are out of order, press the Up 
and Down buttons to get them in order.

Up / Down
Press these buttons to move the highlighted article up or down in the list.    Before viewing or saving 
the attachment, you must make sure that the articles are in the correct order.

View
Press this button to view the attachment.    Agent saves the attachment in a temporary file and then 
passes it to the Windows application associated with the attachment's file type.

Save File
Press this button to save the attachment as a file.

Note: The View and Save File buttons appear dim when the first article in the Articles list does not contain
the beginning of a valid uuencoded file.



View Empty Group dialog box
This dialog box is displayed when your View Empty Group Action in the Retrieving tab of the Group 
Properties dialog box is set to Prompt for Action.

Sample 50 Article Headers
Press this button to retrieve a maximum of 50 article headers for this group.    Note:    The number you
see may not be 50.    The sample size is defined in your Default Group Properties dialog box on the 
Retrieving tab.

Get All Article Headers
Press this button to retrieve all article headers in this group.

Subscribe to Group
Press this button to subscribe to the group.    You can retrieve article headers later by choosing Get 
New Article Headers in Subscribed Group from the Online menu.



Select Signature File dialog box (Signatures dialog box, File menu)
Use this dialog box to find a signature file on your hard disk.

File Name
Enter the name of the signature file, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.



Save Attachment File dialog box (View Binary Attachment dialog box, File menu)
Use this dialog box to save an attachment as a file.

File Name
Enter the name of the file. 

Directories
Select the directory where you want to save the file. 

List of File Types
Select the type of file you want to save the attachment as.

Drives
Select the drive where you want to save the file.



Attach Binary File dialog box (Compose window)
Use this dialog box to attach a binary file to a message.    Agent will automatically uuencode the file for 
you.    Note: If you want to insert a text file into the message, choose Insert Text File from the File menu 
instead.

File Name
Enter the name of the file to attach, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.



Insert Text File dialog box (File menu)
Use this dialog box to insert a text file into a message.

File Name
Enter the name of the file to insert, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.



Browser Font dialog box (File menu)
Use this dialog box to pick the font that groups and articles are displayed in.
Note: Article subjects are displayed in the font controlled by the Article Subject Font dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.



Article Subject Font dialog box (File menu)
Use this dialog box to pick the font that article subjects are displayed in.
Note: The other items in the Article Pane (e.g., number of lines and author) use the font controlled by the 
Browser Font dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular.    Article subjects can be 
easier to read if you select a bold font style.

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.



Variable Pitch Body Font dialog box (File menu)
Use this dialog box to pick the variable pitch font that article bodies are normally displayed in.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.



Fixed-Pitch Body Font dialog box (File menu)
Use this dialog box to pick the fixed pitch font that article bodies are displayed in when you choose Fixed 
Pitch Font from the Article menu.

Font
Type or select a font name.    Courier and Courier New are two examples of fixed pitch fonts.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.



Printer Font dialog box (Page Setup dialog box, File menu)
Use this dialog box to pick the font that articles will print in.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.



How to Send a Binary Attachment
Attaching files to articles and emails is quick and easy with Agent.    Since the Usenet only supports text 
postings, agent automatically translates (uuencodes) all non-text attachments to a standard text-based 
format.    Follow the steps below to attach a file to a message:

1. Create a new article or email message.
Select one of the options on the Post menu to create the message.    Click here for more help sending
articles and emails.

2. Attach the desired file.
Press the Attachment button to browse for the file, or type the file’s name directly into the Attachment 
box.    You can control your attachment options with the Attachments tab on the Preferences dialog 
box.

3. Add a text message (optional).
You can include a message along with the attachment.    The message appears before the 
attachment. If you include a message, Agent also includes your signature.

4. Send the message.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet.

If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Articles and Emails from the Online menu to 
transmit them to the Internet.
Send Later Note:    Agent does not make a copy of the attached file prior to sending it.    If you press 
Send Later, make sure that the file stays around until you transmit it.

See Also:
Making Sure Articles and Emails Were Sent Properly



How to Retrieve a Binary Attachment
Many newsgroups are devoted to the distribution of pictures and sounds.    These binary pictures and 
sounds are posted as text attachments to one or more articles.    Agent makes quick work of translating 
(uudecoding) the text attachments into their binary equivalent.    To retrieve an attachment, follow the 
steps below.

1. Retrieve the bodies of the article(s) containing the attachment.
For more information, see How to Use Agent as an Offline Newsreader or How to Use Agent as an 
Online Newsreader.

2. Select the article(s) that contain the attachment.
If the attachment is contained in a single article, select that article.

If the attachment is split across multiple articles, and if all of the articles are grouped together, select 
just the first article.    Agent will automatically find the remaining articles. 

If the attachment is split across multiple articles, but the articles are not grouped together, select all of 
the articles that comprise the attachment.    To select all of the articles, click on the first article and 
then, with the Control key depressed, click on each subsequent article.

3. Open the View Binary Attachment dialog box.
Choose View Binary Attachment from the File menu.    If you have not yet retrieved the articles 
containing the attachments, you will be asked to do so now.    After the articles are retrieved, try this 
step again.

4. Make sure the articles are in order.
If the articles listed in the dialog box are out of order, use the Up and Down buttons to order them.

5. View or save the attachment.
Agent automatically translates (uudecodes) attachments for you.

To view the attachment, press the View button.    Agent will launch the Windows application 
associated with the attachment's file type.    The file type is determined by the attachment's filename 
extension.    For example, "foo.gif" is a GIF file.    For more information, see How to Configure a GIF or
JPG Viewer to Work with Agent.

To save the attachment, press the Save File button.    Agent will prompt you for a filename.



Getting Started
Getting up and running with Agent is simple.    Just follow the steps below and you’ll be reading articles in 
no time.

1. Set your online preferences.
Choose Preferences from the File menu and select the Online Operation tab.    If you wish to stay 
online with your service provider while using Agent, press the Configure for Online Operation button.   
If you wish to minimize your time online, press the Configure for Offline Operation button.

2. Get a list of groups.
If you did not copy the list of newsgroups from another program or retrieve a complete list when you 
first started Agent, select Refresh Group List from the Online menu.    Since there are several 
thousand groups, this may take a while.    Once the groups are retrieved, Agent will display them in 
the Group Pane.

3. Subscribe to groups.
Scan through the list of groups for ones you want to follow regularly.    To find a particular group, 
choose Find from the Edit menu.

When you find a group that may be of interest, double-click on it.    If you want get a feel for the group 
before subscribing, press the Sample 50 Article Headers button.    If you know you’re interested in the 
group, press the Subscribe to Group button.

If you decide later that you’re interested in a group, you can subscribe to it by selecting Subscribe 
from the Group menu.    A newspaper  appears next to each subscribed group.

4. View only subscribed groups.
From the Group menu, choose Show Only Subscribed Groups.    Now your group pane is filtered to 
show only the groups you’re interested in.    To view all groups again, select Show All Groups from the
Group menu.

5. Retrieve article headers in your subscribed groups.
Choose Get New Headers in Subscribed Groups from the Online menu to download all the article 
headers in all your subscribed groups.

There may be several hundred new articles for each group so this operation may take a while.    But, 
since Agent retrieves articles in the background, you can use your computer for other tasks while 
Agent is working.

6. Browse the article headers.
Once the article headers are retrieved, browse them to see which ones interest you.    If you’re 
configured for online operation, simply double-click or press Enter on an article to retrieve it (see How 
to Use Agent as an Online Newsreader for more information).    If you’re configured for offline 
operation, mark all the articles your interested.    To mark an article, select it and press “M” or choose 
Mark for Retrieval from the Article menu.    When an article is marked, the download arrow  appears 
next to it.

7. Retrieve marked articles.
If you’re configured for offline operation you marked several articles in the previous step.    To retrieve 
the full text of all marked articles, select Get Marked Article Bodies from the Online menu.    See How 
to Use Agent as an Offline Newsreader for more information.

TIP: Clicking the right mouse button in a Newsgroup window displays a Speed Menu, a context-sensitive 
list of common operations.    Simply select an option from the list to quickly perform that action.



Toolbar
The toolbar contains buttons which give you fast access to the most common actions in Agent.
To see what a particular toolbar button does, move the mouse cursor over the button in Agent and a 
ToolTip box will appear with the button’s name.



Group Pane
This is where a list of newsgroups is displayed.    In this pane you can view all newsgroups, only 
subscribed newsgroups, or only new newsgroups.    To change which groups are displayed, choose the 
appropriate option from the Group menu.
Tip: You can also change which groups are displayed by clicking on the header for the group list pane 
(the gray area just above the list).



Article Pane
This is where the articles in the selected group are displayed.    To view articles in another group. select 
that group in the Group pane.



Unread Counter
This number shows you how many articles in the associated group you have not yet read.



Ignore Thread Icon
When this icon appears next to an article, Agent will not retrieve new responses to the article.    To switch 
between ignoring and not ignoring a thread, select Ignore Thread from the Article menu.



Expand Thread Icon
Click this icon to show the article’s responses.



Collapse Thread Icon
Click this icon to hide the article’s responses.



Number of Responses
This is the number of responses to the article.    To view the responses, click the Expand Thread icon .



Number of Lines
This is the number of lines in the article.



Article Body Icon
This icon tells you that the body of the article has been retrieved.



Article Body Not Available Icon
This icon tells you that the article has been deleted from your news server and is no longer available for 
retrieval.



Retrieval Icon
This icon tells you that the body of the article is currently being retrieved.



Watch Thread Icon
This icon tells you that Agent will automatically retrieve the bodies of new responses to this article when 
retrieving new article headers.    To switch between watching and not watching a thread, select Watch 
Thread from the Article menu.



Unread Article
When an article header is displayed in this color it means that you have not yet viewed the article’s body.



Read Article
When an article header is displayed in this color it means that you have already viewed the article’s body.



Mark for Retrieval Icon
This icon tells you that the body of the associated article will be retrieved the next time you select Retrieve
Marked Articles from the Online menu.

When this icon appears next to a group, one or more articles in the group are marked for retrieval.

To mark or unmark an article, select Mark for Retrieval from the Article menu.



Keep Article Icon
This icon tells you that Agent will not automatically delete (purge) the article.    To prevent an article from 
being automatically purged, select Keep Article from the Article menu.    To undo the Keep status, select 
Keep Article again.



Body Pane
This is where an article’s text is displayed.    To view a different article’s body, select the article in the 
article pane.



Status Bar
This area displays information about Agent such as the online status (online or offline), the current task, 
and the number of queued tasks.



Zoom Button
Press this button to maximize the Group, Article, or Body pane.    To restore the window back to showing 
all three panes, press the button that looks like this .



Subscribed Group Icon
This icon appears next to subscribed groups.    To switch between subscribing and unsubscribing to a 
group, select Subscribe from the Group menu.    To view only your subscribed groups, select Show Only 
Subscribed Groups from the Group menu.



New Group Icon
This icon appears next to new groups.    To get the list of groups that have been added to your news 
server since the last time you retrieved groups, select Get New Groups from the Online menu.



Response Article
This article is a response.    Since responses have the same subject as their parent, only the author is 
shown.



Groups
These are the Usenet newsgroups.    To retrieve article headers in a group, select the group and choose 
Get New Article Headers in Selected Groups from the Online menu.



Thread
A thread is a series of related articles grouped together.    For example, when people post responses to a 
question, the question and all responses together are called a thread.



How to Post Articles
Reading newsgroups wouldn’t be much fun if you couldn’t contribute as well.    Fortunately, posting 
articles with Agent is just as easy as reading them.

1. Select the group you wish to post to.
A group is selected when it is highlighted in the Group pane or when you are viewing articles for it in 
the Article pane.    

2. (Optional) Select the article are responding to.
If your article is a follow up to another posting, select that article first so that your posting is properly 
formatted.

3. Open a new Posting window.
From the Post menu, choose New Article or Follow Up Article, depending on the type of posting you 
want.

4. Fill in the Posting window’s fields.
If you selected a group (and article) before opening the Posting window, all of the fields should be 
filled in for you.    If you want to override the default signature, press the All Fields button and select 
the desired signature in the Signature list.    For more information filling in this window, see the 
Compose Article window topic.

5. (Optional) Attach a file.
If you want to attach a file to the new article, enter the file name next to the Attachment button or 
press the Attachment button to browse for the file.    For more information on attaching files, see How 
to Send a Binary Attachment.

6. Send the article.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet.

If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Articles and Emails from the Online menu to 
transmit them to the Internet.
Send Later Note: Agent does not make copies of attached files prior to sending them.    If you attach 
a file and press Send Later, make sure that the file stays around until you transmit the message.

See Also:
Making Sure Articles and Emails Were Sent Properly
ROT13 Encoding and Decoding



How to Send Email
With Agent, sending email to people is a snap and sending email replies to articles is even easier.

1. (Optional) Select the article are responding to or forwarding.
If you’re replying to or forwarding a posting, select that article first so that your email is properly 
formatted.

2. Open a new Posting window.
From the Post menu, choose New Email, Reply via Email, or Forward via Email depending on the 
type of email you want to send.

4. Fill in the Posting window’s fields.
If you selected Reply via Email, the required fields should be filled in for you.    Otherwise, fill in at 
least the To and Subject fields.    Press the All Fields button to send “carbon copies” to other people or
to select a different signature for the email.    For more information filling in this window, see the 
Compose Email window topic.

5. (Optional) Attach a file.
If you want to attach a file to the email, enter the file name next to the Attachment button or press the 
Attachment button to browse for the file.    For more information on attaching files, see How to Send a 
Binary Attachment.

6. Send the email.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet.

If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Articles and Emails from the Online menu to 
transmit them to the Internet.
Send Later Note: Agent does not make copies of attached files prior to sending them.    If you attach 
a file and press Send Later, make sure that the file stays around until you transmit the message.

See Also:
Making Sure Articles and Emails Were Sent Properly
ROT13 Encoding and Decoding



Making Sure Articles and Emails Were Sent Properly
When you first start using a new program, you probably want to make sure it’s doing what you told it to 
do.    To make sure your articles and emails have been successfully sent, choose Open Outbox Window 
from the File menu.    All of the articles and emails you have sent with Agent appear in this window.    The 
icons next to each message tell you the status of that message:

Icon Meaning
The message was successfully sent.
A problem occurred sending this message.    Double-click on the message to make sure all the 

fields are filled in correctly and then press Send Now or Send Later to re-send the message.
The message is queued for uploading (you pressed the Send Later button after creating the 

message).    To send the message now, choose Post Articles and Emails from the Online menu.
The message is in the process of being sent.



Watching and Ignoring Threads
As you probably already know, some groups on the Internet are very active.    There can be several 
hundred new postings a day.    To help you cut through some of this noise, Agent provides you with two 
very powerful yet very simple features: Watching threads and Ignoring threads.

Watching Threads
When you’re browsing though article headers and come upon one that you know you’ll be interested 
in responses to, select Watch Thread from the Article menu or press W.    The Watch Thread icon, , 
will appear next to the article.    Agent automatically retrieves the bodies of all responses to watched 
threads when retrieving article headers.

Ignoring Threads
The opposite of watching threads is ignoring threads.    When you run across an article that you know 
you won’t be interested in responses to, select Ignore Thread from the Article menu or press I.    The 
Ignore Thread icon, , will appear next to the article.    Agent automatically marks the article and any 
responses to it, even those retrieved in later sessions, read.    This can significantly reduce the 
number of new, unread articles presented to you each time you get new article headers.

See Also:
How to Control When Agent Marks Articles Read



Compose Article window (Post menu)
Use this window to create an article to post in a newsgroup.    For more information, see How to Post 
Articles

Newsgroups
Enter the name of the newsgroup you wish to post to.    To post the same article on multiple groups 
(cross-post), enter the names of all the groups separated by commas (e.g., alt.usenet.offline-
reader, alt.winsock).

Subject
Enter a brief phrase describing the article.

Attachment
(Optional) Enter the name of the file to attach to the article or press the Attachment button to browse 
for the file.    For more information, see How to Send a Binary Attachment.

All Fields
Press this button to show the other fields that apply to the article.    Press this button again to hide the 
extra fields.

Expires
(Optional) Enter the date that you want this article to be removed from the news server.    The date 
should be in standard Usenet date format (e.g., Wed, 22 Feb 95 00:36:25 -0800).    Note: This is
just a suggested expiration date and may be ignored by the server.

Follow Up To
(Optional) Enter the name of the newsgroup you want responses to this article posted to.

Organization
(Optional) Enter the organization (university, employer, etc.) you belong to.

Reply To
(Optional) Enter the email address you want replies to this article sent to if you don’t want replies sent
to your normal address.

Signature
Select the signature to place at the bottom of this article.    Choose [None] if you don't want a 
signature added to the article.

Send Now
Press this button to immediately transmit your message to the Internet.    This button appears dim 
when the Newsgroups field is blank.

Send Later
Press this button if you use Agent off line and you have other messages you want to send.    This 
button appears dim when the Newsgroups field is blank.

Once you have composed all your messages, select Post Articles and Emails from the Online menu 
to transmit them to the Internet.    Note: Agent does not make a copy of the attached file prior to 
sending it.    If you press Send Later, make sure that the file stays around until you transmit the 
message.

Save
Press this button to save your article without sending it.    The article will appear in your Outbox.    To 
view your Outbox, choose Open New Outbox Window from the File menu.    You can double-click the 
article in the Outbox to edit and/or send it.

See Also:
How to Send Email
Making Sure Articles and Emails Were Sent Properly
ROT13 Encoding and Decoding



Compose Email window (Post menu)
Use this window to create an email.    For more information, see How to Send Email

To
Enter the recipient’s email address.    To send the same email to multiple people, enter all the email 
address separated by commas (e.g., john.doe@forteinc.com, jane.doe@forteinc.com).

Subject
Enter a brief phrase describing the email.

Attachment
(Optional) Enter the name of the file to attach to the email or press the Attachment button to browse 
for the file.    For more information, see How to Send a Binary Attachment.

All Fields
Press this button to show the other fields that apply to the email.    Press this button again to hide the 
extra fields.

Cc
(Optional) Enter the email addresses of the people to whom you wish to send carbon copies of this 
message.    To send carbon copies to multiple people, enter all the email address separated by 
commas without any spaces.

Bcc
(Optional) Enter the email addresses of the people to whom you wish to send blind carbon copies of 
this message.    To send blind carbon copies to multiple people, enter all the email address separated 
by commas without any spaces.

Reply To
(Optional) Enter the email address you want replies to this message sent to if you don’t want replies 
sent to your normal email address.

Signature
Select the signature to place at the bottom of this email.    Choose [None] if you don't want a signature
added to the email.

Send Now
Press this button to immediately transmit your message to the Internet.    This button appears dim 
when the To field is blank.

Send Later
Press this button if you use Agent off line and you have other messages you want to send.    This 
button appears dim when the To field is blank.

Once you have composed all your messages, select Post Articles and Emails from the Online menu 
to transmit them to the Internet.    Note: Agent does not make a copy of the attached file prior to 
sending it.    If you press Send Later, make sure that the file stays around until you transmit the 
message.

Save
Press this button to save your email without sending it.    The message will appear in your Outbox.    
To view your Outbox, choose Open New Outbox Window from the File menu.    You can double-click 
the message in the Outbox to edit and/or send it.

See Also:
How to Post Articles
Making Sure Articles and Emails Were Sent Properly
ROT13 Encoding and Decoding



ROT13 Encoding and Decoding
Some Internet messages contain text encoded with a scheme called ROT13.    ROT13 encoded text 
cannot be read without first decoding it.    For example, “Hello World” encoded with ROT13 looks like this: 
Uryyb Jbeyq

To decode a ROT13 message:
Select the encoded text and choose Apply ROT13 from the Edit menu or press Ctrl+R.

To encode a ROT13 message:
Select the text to encode and choose Apply ROT13 from the Edit menu or press Ctrl+R.

Note:      When you decode text in an article you have retrieved, the decoding only affects your display.    If
you come back to this article later, you will again see the original, encoded text.    Encoding text in a 
message you're creating, on the other hand, affects the actual text.    If you then post the message, other 
people will see it with the text encoded. 

See Also:
How to Post Articles
How to Send Email



Copying a WWW URL to the Clipboard
Many Internet messages contain addresses of World Wide Web (WWW) pages.    Although Agent doesn’t 
directly support Web browsing, it makes it easy for you to copy these addresses, called URLs, to the 
Windows Clipboard for pasting into another program like Mosaic or Netscape.

To copy a WWW URL to the Clipboard:
While viewing an article with a URL, choose Copy WWW URL from the Edit menu or press Ctrl+U.    
Agent will scan the article starting at the cursor’s current location, highlight the first URL it finds, and 
copy it to the Clipboard.    To search for another URL, simply press Ctrl+U again.    If Agent can’t find 
the URL, you may need to customize the URLPattern setting in AGENT.INI.

To paste a WWW URL into Mosaic:
Launch Mosaic and choose Open URL from its File menu.    Click in the URL field and press Ctrl+V.

To paste a WWW URL into Netscape:
Launch Netscape and choose Open Location from its File menu.    Click in the edit field and press 
Ctrl+V.



Common Internet Acronyms
<BG> Big Grin
<g> Grin
BRB Be right back
BTW By the way
CP Copy protection
FUBAR Fouled up beyond all recognition (or 

repair)
FWIW For what it's worth
FYI For your information
GD&WVVF Grinning, ducking, and walking very, very

fast
GR&D Grinning, running, and ducking
IAE In any event
IANAL I am not a Lawyer
IMHO In my humble opinion
IMO In my opinion
IOW In other words
LOL Laughed out loud
LZ Loser!
OIC Oh, I see
OTOH On the other hand
PITA Pain in the Ass
PMJI Pardon my jumping in
PMFJI Pardon me for jumping in
ROFL Rolling on floor, laughing
ROTFL Rolling on the floor laughing
ROTFLMAO Rolling on the floor laughing my ass off
RSN Real soon now
RTFM Read the f@%# manual (or message)
SNAFU Situation normal, all fouled up
TIA Thanks in advance
TPTB The powers that be
TTFN Ta ta for now

How to Get All the Articles in a Group
Agent provides you with two ways to retrieve the bodies of all the articles in a group:

To always retrieve all the bodies in a particular group:
1. Select the group(s) for which you want to retrieve bodies.
2. Choose Group Properties from the Group menu.
3. Select the Retrieving tab on the Group Properties dialog box.
4. Make sure the “Override default settings” box is checked.
5. Check the “Retrieve bodies for all new articles” box.

To retrieve all the bodies in a group on an ad-hoc basis:
1. Select any article in the Article Pane of the group for which you want to retrieve bodies.
2. Choose Select All from the Edit menu or press Ctrl+A.
3. If you are online, choose Get Selected Article Bodies from the Online menu.    If you are offline, 

choose Mark for Retrieval from the Article menu.    You can later retrieve the marked articles by 
selecting Get Marked Article Bodies from the Online menu.

See Also:
How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader



How to configure a GIF or JPG viewer to work with Agent
The Internet contains a wide variety of graphic images which are usually stored in GIF or JPG formatted 
files.    Although Agent doesn’t display these images directly, you can view them from Agent if you have a 
GIF or JPG viewing program like LVIEW.    To configure your system for viewing graphics from Agent:

1. Run File Manager.
From Program Manager, double-click the File Manager icon.

2. Open the Associate dialog box.
Choose Associate from File Manager’s File menu.

3. Create an association.
In the Associate dialog box, enter GIF or JPG into the Files with Extension box.    Enter the full path of 
your graphics viewer into the Associate With box or press Browse to search for the viewer on your 
hard drive.

See Also:
How to Retrieve a Binary Attachment



How to Use Agent as an Offline Newsreader
If you pay an hourly rate for your Internet connection, an Offline newsreader can save you lots of money 
by minimizing the time you are connected to your service provider.    To use Agent as an offline reader, 
follow the steps below:

1. Make sure you are configured for offline operation.
Choose Preferences from the File menu and select the Online Operation tab.    Press the Configure 
for Offline Operation button and Agent will automatically configure itself for offline use.

2. Get headers for new articles.
To retrieve the headers of all the new articles in all your subscribed groups, choose Get New Headers
in Subscribed Groups from the Online menu.    If you only want the new headers in a particular group, 
select that group and choose Get New Headers in Selected Groups from the Online menu.

Agent will now go online and retrieve the new headers.    As soon as it is done, it will go offline so that you 
are no longer incurring connect charges.

All the article headers Agent retrieved will be colored red (assuming you’re using Agent’s default color 
scheme - see the Preferences dialog box, Colors Tab).    This signifies that the article is new, or “unread.”

3. Mark articles for retrieval.
Browse through the article headers just retrieved and look for ones that interest you.    When you find 
one, highlight it and do any one of the following:

· Click the Mark for Retrieval toolbar icon 
· Choose Mark for Retrieval from the Article menu

· Press the M or Enter key

· Double-click on the article

Repeat the above step for each article whose body you wish to retrieve.

4. Get marked article bodies.
Once you’ve marked all the interesting articles in all your groups, choose Get Marked Article Bodies 
from the Online menu.

Agent will now go online to retrieve the full text of all your marked articles and go offline as soon as it’s 
done.

5. Read the retrieved articles.
Any articles you did not mark in the previous step will automatically have been marked read when you
retrieved marked article bodies in the previous step (see How to Control When Agent Marks Articles 
Read for details).    You can now use the options on the Navigate menu to quickly find and read the 
articles you just retrieved.

See Also:
How to Use Agent as an Online Newsreader
How to Control When Agent Purges Articles
Group Properties dialog box, Retrieving tab



How to Use Agent as an Online Newsreader
If you don’t pay an hourly rate for your Internet connection, you probably want to remain connected to 
your service provider while using Agent.    To use Agent as an online reader, follow the steps below:

1. Make sure you are configured for online operation.
Choose Preferences from the File menu and select the Online Operation tab.    Press the Configure 
for Online Operation button and Agent will automatically configure itself to stay online.

2. Get headers for new articles.
To retrieve the headers of all the new articles in all your subscribed groups, choose Get New Headers
in Subscribed Groups from the Online menu.    If you only want the new headers in a particular group, 
select that group and choose Get New Headers in Selected Groups from the Online menu.    

Agent will now go online if you’re not currently connected to the news server.    It will remain online until 
you manually go offline (by exiting the program or deselecting Online from the Online menu) or it detects 
an extended period of inactivity.

All the article headers Agent retrieved will be colored red (assuming you’re using Agent’s default color 
scheme - see the Preferences dialog box, Colors Tab).    This signifies that the article is new, or “unread” 
(see How to Control When Agent Marks Articles Read for more information).

3. Read articles.
To read an article, simply double-click on it or highlight it and press Enter.    You can also use the View
Next Unread Article (Ctrl+N) and View Next Unread Article in Thread (Ctrl+T) options on the Navigate 
menu to jump to the next unread article and retrieve its body at the same time.

See Also:
How to Use Agent as an Offline Newsreader
How to Control When Agent Purges Articles
Group Properties dialog box, Retrieving tab



Article Header
A brief description of an article.    An article’s header contains key information about the article, such as its 
author and subject, but does not include the text, or “body,” of the article itself.



Article Body
The actual text of an article.    The other components of an article, such as its subject, author, etc., are 
called the article’s “header.”



How to Control When Agent Marks Articles Read
New articles you retrieve are initially marked unread.    When you view the article’s body, Agent then 
marks that article read.    Since you probably don’t read all the articles whose headers you retrieve, Agent 
automatically marks the articles you don’t care about as read.

To control when Agent automatically marks articles read:
By default, Agent automatically marks unwanted articles read whenever you retrieve article headers 
or bodies.    This makes it easy for you to find the new articles because they will be the only ones 
which are unread.    To change this behavior, choose Group Properties from the Group menu and 
select the Marking Articles Read tab.

To manually mark articles read:
Select the articles you want to mark read and choose Mark Article Read from the Article menu.    To 
mark all the articles in a group read, select the group and choose Mark All Articles Read from the 
Article menu.

To manually mark an article unread:
Select the articles you want to mark unread and choose Mark Article Unread from the Article menu.    
To mark all the articles in a group unread, select the group and choose Mark All Articles Unread from 
the Article menu.

See Also:
Watching and Ignoring Threads



How to Control When Agent Purges Articles
In general, Agent automatically deletes, or “purges,” old articles for you.

When does Agent purge articles:
Agent purges a group’s old articles whenever it retrieves new article headers for that group.    For 
example, all the old articles in your subscribed groups will be purged when you select Get New 
Headers in Subscribed Groups.

Which articles does Agent purge:
You define the articles purged by Agent in the Purging tab of the Group Properties dialog box.    

To manually delete an article:
Select the article(s) and choose Delete Article from the Article menu.    A message will appear asking 
you to confirm the delete action.    To turn off the delete confirmation message, see the Confirmations 
tab of the Preferences dialog box.



AGENT.INI
;======================================================================
[Profile]
FullName=
;Your full name as you want it to appear in your messages.
;You may leave this blank.

EMailAddress=
;Your email address

ReplyTo=
;Where replies to your messages should be sent,
;if different from your email address.

Organization=
;Your organization.
;You may leave this blank.

DoAuthorization=0
;Perform authorization login to news server

SavePassword=1
;Save authorization password between sessions

UserName=
;News server authorization username

Password=
;News server authorization password

IsLicensed=0
;User has accepted the license agreement

IsRegistered=0
;User has posted a beta registration (Post|Comments)

;======================================================================
[View]
AutoOpenMode=1
;Automatically maintain positioning in subsidiary browsers when
;the highlight in a browser changes.

ShowToolBar=1
;Display the toolbar at the top of the screen

ShowStatusBar=1
;Display the statusbar at the bottom of the screen

StatusBarFont=MS Sans Serif, 80, 0, 0, 0,0,0
;Font used for text in the status bar.

InitialView=1
;Specifies the initial view for the Group Pane:
; 0 - All Groups
; 1 - Subscribed Groups
; 2 - New Groups

MainWindowPosition="0 1 -1 -1 -4 -4 86 57 875 677"
;Initial screen position of the program's main window



BrowserPosition="3 3 94 347 -4 -23 15 18 663 348"
;Initial screen position of the browser

;======================================================================
[Browser]
NormalFont=Arial, 80, 0,0, 0,0,0
;Font for normal items
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

BoldFont=MS Sans Serif, 80, 1,0, 0,0,0
;Font for special items( e.g. first article in thread)
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

ScrollMargin=2
;The minimum number of lines to maintain above and below the highlighted
;item when scrolling with the cursor keys.  This keeps the highlight
;from getting pinned at either the top or bottom screen rows.

FollowUpIndent=4
;Amount to indent follow-up articles in the article list pane,
;in characters.

MaxNestLevel=6
;The max indentation level for response articles in the article list
;browser.  The absolute maximum level allowed is 15.

CollapseThreads=1
;Initially collapse threads in the article list pane.

ExpandNewThread=0
;When positioning on a new article, automatically expand the thread
;if the article is a follow-up and if the first article in the thread
;has been retrieved.

SubjectThreading=1
;Use subjects to combine articles into threads, in addition to message
;references.

ArticleListColumns=147,745
;Offsets of the left edges of the columns in the article browser pane,
;in units of 10x the average character width.
;The edge of the left-most column is always zero, so is not included here.

OutBoxColumns=87,432,697
;Offsets of the left edges of the columns in the outbox browser,
;in units of 10x the average character width.
;The edge of the left-most column is always zero, so is not included here.

;======================================================================
[Article]
VariableFont=MS Sans Serif, 100, 0,0, 0,0,0
;Variable-pitch font for the article body viewer
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

FixedFont=Courier, 100, 0,0, 0,0,0
;Fixed-pitch font for the article body viewer
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

UseFixedFont=1
;Use the fixed-pitch font for articles



WordWrap=1
;Word wrap articles

ShowHeader=1
;Show all header fields in articles

QuotedTextMarkers=>:|}
;The characters that mark a quoted line of text in an article.
;If a line begins with any of these characters, it is assumed to be quoted.

URLPattern=[a-zA-Z]+:/[^ \t\r\n>)\]"']*[a-zA-Z0-9/]
;A regular expression defining the pattern for URLs

TabSpacing=3
;Tab spacing for articles.

SaveArticleFields=2
;Controls which header fields to save when writing an article to a text file
; 0 No fields
; 1 Subject, author, and date only
; 2 All fields

SaveArticleAppend=0
;If the file to which an article being saved already exists, append to it.
;Otherwise, overwrite the file after prompting for verification.

;======================================================================
[Groups]
LastUpdate=
;The most recent date and time at which the program retrieved a list
;of new usenet groups, in GMT.  When the program retrieves a list of new
;groups, it asks for all groups created after this date.
;
;Setting this to blank forces the program to retrieve a list of all groups.

;======================================================================
[Servers]
NewsServer=
;The name of the NNTP news server

MailServer=
;The name of the SMTP mail server

NNTPPort=
;Winsock port to use for connecting to the NNTP news server.
;This param is used only if the winsock getservbyname() call fails.

SMTPPort=
;Winsock port to use for connecting to the SMTP mail server.
;This param is used only if the winsock getservbyname() call fails.

;======================================================================
[Online]
AutoDisconnect=1
;Disconnect from news server after <NoActivityTimeout> seconds of inactivity.
;Zero means never disconnect.

NoActivityTimeout=300
;Period of no activity after which the program should disconnect
;from the NNTP server (seconds).



MailAutoDisconnect=1
;Disconnect from mail server after <MailNoActivityTimeout> seconds of
inactivity.
;Zero means never disconnect.

MailNoActivityTimeout=5
;Period of no SMTP activity after which the program should disconnect
;from the SMTP server (seconds).

SendKeepAliveMsgs=1
;Send "keep alive" messages to the news server.
;This keeps the dial-up connection alive.

KeepAlivePeriod=60
;How often to send a keep alive message during periods of inactivity.

XHdrOnly=0
;Use XHDR commands to request article header information from the news
;server, rather than XOVER.  Some servers do not support the newer
;XOVER command, which is faster than XHDR.  The program automatically
;detects whether the server recognizes XOVER and falls back to XHDR
if it doesn't.  But, you can also use this option to force it to
;always use XHDR.

EnablePriorityTask=1
;When non-zero, enable priority tasks for retrieving article bodies.
;This allows the program to open two channels to the news server,
;with one reserved as a priority channel for retrieving articles.

AutoView=0
;What to do when you double-click on an article witout a body
; 0 Retrieve the article's body
; 1 Mark the article for later retrieval
; 2 Retrieve the body if online, mark for later retrieval if offline
; 3 Do nothing

;======================================================================
[Timing]
GetHostByNameTimeout=30
;Timeout period for looking up the host's name (seconds)

ConnectTimeout=10
;Timeout period for connecting to host (seconds)

ResponseTimeout=120
;Timeout period for waiting for a response from the host (seconds)

SendTimeout=60
;Timeout period for sending a command to the server (seconds).
;This is the maximum time the program will wait during a blocked transmission,
;not the total time allowed to send a message.

PostTimeout=60
;Timeout period for posting an article or email message (seconds).
;This is the maximum time the program will wait during a blocked transmission,
;not the total time allowed to send a message.

SplashTime=5
;Minimum time to display the splash screen (seconds)

;======================================================================



[TimeZone]
MinutesFromGMT=-480
;The local timezone, in minutes from GMT.
;If ObserverDST is true, this should be the offset for standard time.

ObserveDST=1
;Automatically adjust the timezone offset to account for DST
;between April and October.

;======================================================================
[Message]

UseFixedFont=1
;Use the fixed-pitch font for outgoing messages

WordWrap=0
;Word wrap outgoing messages in the display window

IncludeOriginalText=1
;Automatically include the text of the original article when creating
;a follow-up article or email reply.

QuotePrefix="> "
;String used to quote text from the original article when creating
;a follow-up article or email reply.

FollowupString=%from% wrote:\n
;The string used to generate the first line(s) of a follow-up article.
;If the string is blank, no first line is generated.
;
;Text enclosed in %...% are the names of fields from the original
;article.  Two %% represent a single % literal.
;
;In addition to the standard article fields, the program supports these
;special fields:
; %Full-Name% Full name of author
;
;You may also use the following escape sequences:
; \n newline
; \t tab
; \\ the backslash character itself

MailReplyString=On %date%, you wrote:\n
;The string used to generate the first line(s) of an email reply.
;If the string is blank, no first line is generated.
;Uses the same formatting commands as FollowupString.

LineLength=70
;The maximum line length for outgoing messages.
;The program word-wraps longer lines.
;Setting this to zero disables word-wrap in outgoing messages.

SaveSentMessages=1
;Save messages that have been successfully posted in the outbox.

SendTagLine=0
;Includ the Free Agent advertisement tag line at the bottom of messages.

;======================================================================
[Directories]
Attachments=C:\AGENT\, *.txt, 0



;Default directory and file type for saving and sending attachments

Files= C:\AGENT\, *.txt, 1
;Default directory and file type for importing and exporting text files

Signatures= C:\AGENT\, *.TXT, 1
;Default directory and file type for signature files

;======================================================================
[Confirm]
DeleteGroup=1
;Confirm group deletions

StopTasks=1
;Confirm actions that would cancel active online tasks

DeleteArticle=1
;Confirm article deletions

DeleteOpenMessage=1
;Confirm closing message composition window if the user has modified
;the message

DeleteOutboxMessage=1
;Confirm message deletions in the outbox

CloseWithTasks=1
;Confirm program close when tasks are running

DefaultAction=0
;Default key in confirmation dialogs, 0=NO, 1=YES

;======================================================================
[Colors]
BrowserNormalColor=0,0,0
;Color for normal articles
:<red>,<green>,<blue>

BrowserUnreadColor=128,0,0
;Color for unread articles.
:<red>,<green>,<blue>

BrowserSelectedUnreadColor=255,255,0
;Color for unread articles that are selected (highlighted).
;Normally, this should be the inverse of the control pane highlight color.
:<red>,<green>,<blue>

ArticleNormalColor=0,0,0
;The color for normal text in articles.

ArticleQuotedColor=0,0,255
;The color for quoted text in articles.
;A line is quoted if it begins with one of the QuotedTextMarkers.

;======================================================================
[Attachment]
PartitionMode=1
;Controls how attachment messages are partitioned:
; 0 Partition into messages (AttachmentPartitionSize controls size)
; 1 Do not partition (send as a single message)



PartitionLines=900
;When attachment messages are partitioned, the maximum number of lines
;of data to send per message.  Each line contains 45 bytes of data,
;and consists of 63 characters.

TextMode=0
;Controls if and how text is sent with attachments
; 0 Send text as separate preface message
; 1 Include text at beginning of first partition message
; 2 Send no text

FileMode=644
;Unix file mode for attachment files.  This is a string.
;This is the mode that is included at the top of the uuencoded file.

;======================================================================
[Print]
LeftMargin=75
TopMargin=75
RightMargin=75
BottomMargin=75
;Margins for printing, in 1/100 inch increments.

Fields=1
;Header fields to include in printed messages
; 0 No fields
; 1 Subject, author, and date only
; 2 All fields

PageBreaks=0
;Where to put page breaks
; 0 None
; 1 Between articles
; 2 Between threads

Font=Times New Roman, 100, 0,0, 0,0,0
;Printer font




